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1. Module Overview

"Manage configuration files on multiple distributed servers from text definitions held in
a central file repository with Sysgem File Synchronizer (SFiS)"

SFiS provides a complete and secure environment to build a central store of "source”
configuration definition files. They define how "target" configuration files should look
including all the variations required for each separate server.

Use Sysgem File Synchronizer to:
e Monitor files on remote servers from a central point.

e Raise automatic alarms when unexpected changes occur.
e Distribute and deploy configuration file updates.
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Control access to this powerful yet "simple to use" tool and delegate options to a very
fine level of granularity with precision and confidence. All options used are fully
audited and may subsequently be browsed and analyzed.

... and why stop at configuration files? Indeed any file required on multiple servers
can be handled by Sysgem File Synchronizer (SFiS).



1.1 Central Source File Manager

The SFiS GUI lists source files permitted for each user to edit, to create new files, to
delete old ones, etc. Source files contain details of the text to be stored on target
servers and also have meta-language rules to define variants for different servers.

The meta-language comprises an extremely simple set of clauses. A clause is a
single character placed in the first character position in each line of a source file. A
clause defines whether the rest of the line is:

text for the target file;

a specification of the name and location of the target file;
for which server the particular text applies;

etc.

All changes to source files are audit logged giving details of who made the change,
which files were changed, etc.

Source files are held in a single Sysgem folder stored with restricted access. The
files incorporate a check-sum and are encrypted for maximum integrity and security.

1.2 Distribution / Deployment of Configuration Files

Lists of servers and configuration files show whether updates are required to
individual files / servers. Drilling down into individual files show the details of
discrepancies between the central source definition and the target file. Those files
needing an update are selected and, with a single key click, synchronized with the
central definition.

1.3 Automatic Monitoring of Target Configurations

It is very easy to set up "Unattended Mode Operations" to periodically and continually
monitor the state of target files by comparing them to their central source definition.
The frequency of refreshing a report can be as short or as long as you wish.

When your criteria for taking action are met, an alarm is automatically triggered and
the action taken, such as to notify by email the details of the inconsistency.

Interactively browse the network at any time and take a report of the current situation.
Save this information as an HTML report or as a spreadsheet/text file/MS Word
document/etc.

1.4 Configuration Management

Shell commands are run, as a pre- or post- file-update task, to take configuration
action on the impending or completed file-update. Customer and server specific shell
commands are embedded in the source file and are automatically invoked as part of
the file synchronization task.

Typical files controlled by Sysgem File Synchronizer are:



/etc/sudoers
/etc/hosts
/etc/crontab
/etc/sysctl.conf
/etc/group
/etc/shells
/etc/services

1.5 Access Control & Audit Trail Logging

Access to the File Synchronizer and all the individual features within it can be
controlled per user. Different levels of privileges can be given to different users. For
example, control access to:

Named servers

Nominated files (both target and source files)
Script commands

Menu options

etc.

All actions taken by individual users to source files or target systems are recorded in
a central Audit Trail database.

An Audit Browser window is provided with the product allowing all past events taken
by the product to be reviewed, analyzed and included in reports.

1.6 Administrator Access Control

Control the level of access by the SFiS administrators by setting Sysgem Enterprise
Manager (SEM) Access Control Tokens.

SFiS is provided with an 'Access Control Token' with a set of different privilege level
settings. The name of the token is "SFiS File Synchronizer". To create different
categories of SEM users with different privilege settings you first need to copy this
token giving each copy a name that reflects the category type. Then change the
privilege settings for each copy and finally allocate the appropriate named tokens to
the "SEM Profiles" for the different categories of users. (Note that each category of
user also needs its own named copy of a SEM Profile).

Step 1: Use the main SEM menu option: Managers -> SEM Users -> Tokens.

Step 2: Copy the token: "SFiS File Synchronizer" by selecting (highlighting) the
token and pressing the "Copy" icon at the top of the Account Tokens page. A new
token will be created called "Copy of SFiS File Synchronizer".

Step 3: Double click on the new token copy and rename it by changing the "Title"
field. (Note that it is important not to change the "Token Id" field which should remain
as "SFiS File Synchronizer").

Step 4: change the privilege settings in each copy of the token. The following table
shows the settings that are available:



Token Folder Token Setting Option Comment
Database Database Type MS Access The database for the Audit Log can be contained within MS Access or
MS SQL Server. The default is "MS Access".
MS SQL Server |To switch to SQL Server, create an empty database using the SQL
Server Enterprise Manager, then change the ODBC System DSN setting
on the SEM Authorization Server to point to the new database just
created. The schema is set up automatically by SEM when the database
is first accessed.
Encryption Can Define Own Encryption Key Yes
No
Default Encryption Key <value> This is the key that will be used if the user does not define their own key.

It should be changed on installing the product

Inclusions/Exclusions

Source File Exclusions

<multiple entries>

These are customer defined entries giving the details of source files that
the user is not permitted to access. Use wild cards in defining their
names. It would be possible to have a single entry here with just a single
wild card - i.e. prohibit "all" source files. The "Inclusions" list takes
priority over exclusions, so in the case of all files being excluded, the
"Inclusions” list would be the definitive list of source files that the user is
permitted to access. Add further entries by selecting the "Value" ->
"Plus" option.

Source File Inclusions

<multiple entries>

See comment above re: Exclusions.




Target File Exclusions

<multiple entries>

These are customer defined entries giving the details of target files that
the user is not permitted to access. This means that if users did have
acces to the source file, they would not be able to Synchronize with the
file if it referenced a prohibited target file. Use wild cards in defining the
names of files. It would be possible to have a single entry here with just
a single wild card - i.e. prohibit "all" target files. The "Inclusions” list
takes priority over exclusions, so in the case of all files being excluded,
the "Inclusions” list would be the definitive list of target files that the user
is permitted to access. Add further entries by selecting the "Value" ->
"Plus" option.

Target File Inclusions

<multiple entries>

See comment above re: Exclusions.

Menu Options
(Source Files)

Create Source File

Edit Source File

Show Source and Expanded Includes
Copy Source File

Rename Source File

Delete Source File

Import Source File

Export Source File (to text file)
View as Excel Report

Audit Browser

Unlock Source File

Repair Checksum

Change Encryption Key

checkbox

Menu option permitted or not

Menu Options
(Synchronize)

Start Synchronize Target Files - UNIX
List Source File

List Target File

Show Differences




Update Target File

Permitted File Types
(Encoding)

Blowfish File Encryption (bfe)
Text (txt)

checkbox

Encrypted files permitted or not
Text Files permitted or not

(Folders)

UNIX Source Files
UNIX Include Files

UNIX Source folder permitted for access or not
UNIX Include folder permitted for access or not

Source File Privileges
(Permitted Clauses)

"T" (Title)

"F" (Target File Specification)

"A" (Agent entry)

"G" (Agent Group)

"#" (Comment)

"D" (Data)

"I" (Insert text file)

"C" (Insert command file)

"S" (Shell commands, pre-update)
"W" (Shell commands, post update)
"V" (Variables)

Whether allowed to edit the source file and change this clause.

Shell Privileges

"Run Shell Commands"

checkbox

Whether allowed to run a Synchronize script that contains shell
commands. The script will be rejected when the user tries to update the
target systems if this token setting has not been granted.




2 SFiS Source File Manager

2.1 Description

This window lists the available source files and include files.

Existing files may be edited, new ones created, and old ones deleted, etc. Source files contain details of the text to be stored on target servers
and also have meta-language rules to define variants for different servers.

The meta-language comprises an extremely simple set of clauses. A clause is a single character placed in the first character position in each
line of a source file. A clause defines whether the rest of the line is:

text for the target file;

a specification of the name and location of the target file;
for which server the particular text applies;

etc.

The table below shows a list of all the clauses defined in the meta language:

Clause Description
T A title which is added to the top of this display
F The agent to which this definition applies (or a wild card "' for all servers) plus the target file
specification.
For example: F Linux001 /etc/services
A A = <name> = only this agent name

A + <name> = add agent name




A ++ = add all agents
A - <name> = remove agent name
A —— = remove all - resets the list

Agent group. Format:

G <group> agent, agent, ...

Example:

G GRPOO1 SUNOO1,HP0O1

Group GRP001 contains SUN0O0O1 and HP0O1. GRP001 can be used in any subsequent "A" entry, in
place of the agent name.

Groups defined in the SEM framework may also be used here.

A file containing lines of commands to be added, full path required.

C <filename>

Example:




C \UNIX_Include\commands.txt

Each line in data.txt is added and processed.

A file containing lines of data to be added in D format. The file needs to exist in the "Include" folder.

I <filename>

Examples:

I \UNIX_ Includel\datal.txt (stored as a text file)

I \UNIX_TInclude\data2.bfe

Each line in data.txt is added with a D inserted at the beginning.

File data for the currently active agents.

{{Agent-SpecificVariables}}

Agent Specific Variables are contained within a double set of braces and can be positioned in any part
of a "Data" line. The variable name (and braces) will be substituted with server specific text that has
been associated with each variable when the source file is synchronized with target systems and the
target files updated. To define a set of Agent specific variables use the following SEM Menu options:

Main SEM Menu: "Managers" ->

"Agents" —->




(select or create an Agent)
"Edit"
(Press the "Custom Variables" button)
( press "Add")
(Enter variable name and value)

(press "OK" on each open window to save)

Optional pre-processing script for the currently active agents.

Optional post-processing script for the currently active agents.

Variable definition and substitution within a source file

Definition:

V <name> <value>

Example:

V USER Albert Jones

V SID 1000

Substitution:




Replaces {{USER}} with Albert Jones and {{SID}} with 1000 in the file data.

Scope:

The "V" clause operates within the context of Agents. e.g.

A --

A + serveri

V USER Albert Jones
A --

A + server2

V USER James Smith

A ++

... will replace {{USER}} in the data section with "Albert Jones" on server1 and "James Smith"

on server2

To see an example of a source file use the menu option "Load Example Source File". This will create a file in the source folder which can then
be edited to show examples of the use of the meta-language clauses.

All changes to source files are audit logged giving details of who made the change, which files were changed, etc.
Source files are held under a central Sysgem folder and stored with restricted access. The files incorporate a checksum and are encrypted for
integrity.



There are three folders, one for each of the platform types and within those a folder for
Source files and a folder for the include files that the source files reference:

» File Sync Source (<server holding the sources>)
- UNIX

o Source Files
o Include Files

- VMS

o Source Files
o Include Files

- Windows

o Source Files
o Include Files

In order to run the Synchronize display using the correct platform type, the source files need to
be held within the source folder for the appropriate platform.

Embedded script commands are written in the appropriate command language depending on the
platform type, as follows:

e UNIX/Linux : Korn shell
e VMS : DCL
e Windows : Perl 5

Examples of embedded commands that are run as pre-processing and/or post processing scripts
during an update of a target file are included in the example source files. Import an example
source file by first selecting the appropriate platform source folder and then using the menu

option: Import/Export: "Load Example Source File".

This Display was created 26-Nov-2009 by Sysgem AG

2.2 Menu Options

2.2.1 Create

Select the required 'File Synchronizer Source File' and use this menu option to edit the
content of that file.

The Notepad editor will be displayed with the content of the file. On completion of the
edit, save the file and exit the editor.

The source file will be updated and will be available for the next 'File Synchronize'
against the target files.



For information on the format required for the source file, see the help on the main
SFiS Source File Manager window. You can also import an example source file from
the 'Import / Export' menu options.

2.2.2 Edit

Select the required 'File Synchronizer Source File' and use this menu option to edit the
content of that file.

The Notepad editor will be displayed with the content of the file. On completion of the
edit, save the file and exit the editor.

The source file will be updated and will be available for the next 'File Synchronize'
against the target files.

For information on the format required for the source file, see the help on the main

SFiS Source File Manager window. You can also import an example source file from
the 'Import / Export' menu options.

2.2.3 Copy

Use this menu option to make a copy of a file.
You will be prompted for a new file name. The file extension (such as .txt or .bfe) for

the new file will be taken from the original file, so do not type it as part of the new file
name.

2.2.4 Rename
Use this menu option to rename a source file.
You will be prompted for a new file name. The file extension (such as .txt or .bfe) for

the new file will be taken from the original file, so do not type it as part of the new file
name.

2.2.5 Delete

Select the required 'File Synchronizer Source File' and use this menu option to delete
that file.

Please note that this action cannot be 'un-done'.

2.2.6 Synchronize UNIX Target Files

Use this option to synchronize the selected source file against target UNIX / Linux
servers.

You will be presented with a startup window prompting for the 'SEM Agents' to
connect. Select the Agents appropriate for the selected source file, then press "OK".
The Source file will be sent to the SEM Agents on the target servers and a comparison
of its content against the content of the target files will produce a display showing



which servers have the same file content as the source file, and which servers are
different.

Differences for each server may then be given as detail, and the servers that have
different file content can be brought into line with the source file by using the "Update
Target Files" option.

2.2.7 Synchronize VMS Target Files

Use this option to synchronize the selected source file against target OpenVMS
servers.

You will be presented with a startup window prompting for the 'SEM Agents' to
connect. Select the Agents appropriate for the selected source file, then press "OK".
The Source file will be sent to the SEM Agents on the target servers and a comparison
of its content against the content of the target files will produce a display showing
which servers have the same file content as the source file, and which servers are
different.

Differences for each server may then be given as detail, and the servers that have
different file content can be brought into line with the source file by using the "Update
Target Files" option.

2.2.8 Synchronize Windows Target Files

Use this option to synchronize the selected source file against target UNIX / Linux
servers.

You will be presented with a startup window prompting for the 'SEM Agents' to
connect. Select the Agents appropriate for the selected source file, then press "OK".
The Source file will be sent to the SEM Agents on the target servers and a comparison
of its content against the content of the target files will produce a display showing
which servers have the same file content as the source file, and which servers are
different.

Differences for each server may then be given as detail, and the servers that have
different file content can be brought into line with the source file by using the "Update
Target Files" option.

2.2.9 View Source File -> Show Source + Expanded Includes

Use this option to view the selected source file together with the expanded include
files.

The data will be shown in the results pane after the option has been invoked.

2.2.10 View Source File -> View as Excel Report

This option analyses the selected source file, incorporates any include files that are
referenced within it, and displays the file as a Microsoft Excel spreadsheet with each
line of the file listed on separate lines in the spreadsheet.



Importantly, the spreadsheet also has columns that show which lines within the file
apply to which servers. Each referenced server has a column in the spreadsheet to
indicate whether each source line applies to that server or not.

The servers used for comparison in the report are those that have been selected int the
"Agents in Report" field.

2.2.11 View Source File -> View as Data for Agent

Use this option to view the selected source file together with the expanded include files
as it will be transmitted to a particular Agent for Synchronization.

The data will be shown in the results pane after the option has been invoked.

2.2.12 Import / Export -> Import Source File (from text)

Use this option to import a new source file from an existing text file held outside of the
File Synchronizer system - such as a file on your workstation.

You can browse for existing text file and you will be prompted for a file name for the
new source file. The file extension (such as .txt or .bfe) for the new file will be taken
from the original file, so do not type it as part of the new file name.

2.2.13 Import / Export -> Export Source File (to text)

Use this option to export an existing source file from to a new text file to be stored
outside of the File Synchronizer system - such on your workstation.

You can browse for a place to store the text file.

2.2.14 Import / Export -> Load Example Source File

Create a Source File based on an example file that gives some of the features
available to the Sysgem File Synchronizer.

You will need to select two UNIX servers that already have SEM Agents installed when
creating this example source file. Those definitions of those Agents will also need to be
modified to include some custom variables used in the example file. To modify the
definition of the Agents use the main SEM menu option: "Managers" -> "Agents". When
modifying the agents select the two agents in question, in turn, and then select the
"Custom Variables" option to add the following four variables to each agent.

LinuxAgent1 LinuxAgent2

Variable Variable Variable Variable
Name: Value: Name: Value:
COLOR Red COLOR Blue

IPADDRESS 123.456.2.123 IPADDRESS 123.456.2.124
PORT 7251 PORT 7252

SVRNAME LinuxAgentl SVRNAME LinuxAgent2



When typing the above information into the Agent Manager definitions - use
appropriate values for the agent names etc. for the agents chosen. This information will
only be stored in a tmp example file on the those server systems.

The example source file will expect a file on each server, as follows :

/tmp/FileSync/FileSync-Demao.ixt

It will then update that file to reflect the content of the source file. The source file may
be modified and used again for comparison with the files on the target servers.

2.2.15 File Maintenance -> Lock File
Use this menu option to lock a file and prevent it from being edited.
Please note that a locked file will still be available for synchronization.

Use the "Unlock" option to release the file for subsequent editing.
2.2.16 File Maintenance -> Unlock File

At the start of an editing session, File Synchronizer Source files are 'locked' to prevent
other users from attempting an edit of the same file at the same time. If for any reason
the editing session is not terminated normally, then the file can remain in its 'locked'
state.

Use this menu option to unlock the file and release it for further editing.

Please note that unlocking a locked file will prevent the user from completing an edit if
the edit session is still underway. Any edited data will be lost.

2.2.17 File Maintenance -> Repair Checksum

File Synchronizer Source Files are protected with a checksum to ensure that the file
has not been corrupted while being stored. If the checksum does not match the content
of the source file, an edit of the file will be blocked and an error message will be
displayed at the start of the edit session.

Use this menu option to repair the checksum - i.e. to force the checksum to be
consistent with the content of the file.

Repairing the checksum of the file will NOT repair the CONTENT of the file, so the
corruption will still exist in the file and for this reason the content should be carefully
checked after using the 'Repair Checksums' menu option by editing the file after the
checksum has been repaired.

2.2.18 File Maintenance -> Change Encryption Key

Select the required 'File Synchronizer Source File' and use this menu option to change
the encryption key for accessing the file.



Note that this option can be used only if the old encryption key is known and the file is
accessible by using this key.

Also note that any include files referenced in a source file will also need to have the
same encryption key defined.



3 SFiS File Synchronizer - UNIX

3.1 Description

This is the Synchronize display that is used to report on the status of the target files. It
compares the target files with the definition held in the central source file. When the
target files are different to the central source file they are marked as "Different" and
may be selected and updated using the menu option "Update Target File".

The following menu options are available on this display:

List Source File
List Target File
Show Differences
Update Target File

The following table shows the column headers on this display window:

Layout
Column Description

(O] The name of the implementation of the target operating system. The value comes
from uname -s on the target system.

OS Version The operating system version, from uname -v.

Source File The source filename.

Target File The target filename for this SEM agent as extract from the central file repository.

Status The update status: tick = no update needed, warning = update needed, cross =
error (for example file not found).

Difference An explanation of the status, for example Same, Different or if there is an error

then specific error text, for example File "/tmp/sysgem_sun_crontab" not found.

Current Size

The current size of the target file in lines.

Update Size

The number of lines in the target file if it is updated.

Checksum

When the target files conform to the source file they show that the files are the
'Same' in the Difference column, but one target system may differ from another
because of the rules in the source file. To show which target systems have the
same content as other target systems, the files are check-summed. When the
checksum is the same as another system, then the files really are the same! To
arrange servers into groups with the same file content - sort the display by clicking
on the "Checksum" column header. This sorts the lines in the display based on
their checksum value.

Folder

This is the Source File folder or Include File folder in which the file resides.




Platform This is the root of the Source File and Include File folder in the central repository.

This display created 06-Apr-2004 by Sysgem AG

3.2 Startup

Select the SEM Agents on UNIX / Linux servers where a comparison is to be made of
target files against the selected source file.

3.3 Menu Options

3.3.1 List Target File

This option lists the current contents of the target file; no updates are made.

3.3.2 List Source File

This option lists the updated contents for the file based on the central database.

3.3.3 Show Differences

This option show the differences between the update file and the current target file.

3.3.4 Update Target File
This option:

1. Runs the pre-processing script.
2. Updates the target file by copying the new contents over the existing contents.
3. Runs the post-processing script.



4 SFiS File Synchronizer - VMS

4.1 Description

This is the Synchronize display that is used to report on the status of the target files on VMS servers. It compares the target files with the
definition held in the central source file. When the target files are different to the central source file they are marked as "Different" and may be
selected and updated using the menu option "Update Target File".

The following menu options are available on this display:

List Source File
List Target File
Show Differences
Update Target File

The following table shows the column headers on this display window:

Layout

Column Description

oS The VMS Operating System and version number.

Source The source filename name (without the file extension).
File

Target The target filename for this SEM agent (as extract from the central file repository).
File




Status

The update status: tick = no update needed, warning = update needed, cross = error (for example file not
found).

Difference | An explanation of the status, for example Same, Different or if there is an error then specific error text, for
example File "/tmp/sysgem_sun_crontab" not found.

Current The current size of the target file in lines.

Size

Update The number of lines in the target file if it were updated.

Size

Checksum | When the target files conform to the source file they show that the files are the 'Same' in the Difference column,
but one target system may differ from another because of the rules in the source file. To show which target
systems have the same content as other target systems, the files are check-summed. When the checksum is
the same as another system, then the files really are the same! To arrange servers into groups with the same
file content - sort the display by clicking on the "Checksum” column header. This sorts the lines in the display
based on their checksum value.

Temp File | This is the name of a temporary file used for updating the target file. It is automatically removed after the update.

This display created 08-Feb-2010 by Sysgem AG




4.2 Startup

Select the SEM Agents on OpenVMS servers where a comparison is to be made of target files against the selected source file.

4.3 Menu Options

4.3.1 List Target File

This option lists the current contents of the target file; no updates are made.

4.3.2 List Source File

This option lists the updated contents for the file based on the central database.

4.3.3 Show Differences

This option show the differences between the update file and the current target file.

4.3.4 Update Target File
This option:

1. Runs the pre-processing script.
2. Updates the target file by copying the new contents over the existing contents.
3. Runs the post-processing script.



S SFiS File Synchronizer - Windows

5.1 Description

This is the Synchronize display that is used to report on the status of the target files on Windows servers. It compares the target files with the
definition held in the central source file. When the target files are different to the central source file they are marked as "Different" and may be
selected and updated using the menu option "Update Target File".

The following menu options are available on this display:

List Source File
List Target File
Show Differences
Update Target File

The following table shows the column headers on this display window:

Layout
Column Description
oS The name of the implementation of the target operating system.

OS Build The operating system build number




Source

The source filename name (without the file extension).

File

Target The target filename for this SEM agent (as extract from the central file repository).

File

Status The update status: tick = no update needed, warning = update needed, cross = error (for example file not
found).

Difference | An explanation of the status, for example Same, Different or if there is an error then specific error text, for
example File "/tmp/sysgem_sun_crontab" not found.

Current The current size of the target file in lines.

Size

Update The number of lines in the target file if it were updated.

Size

Checksum | When the target files conform to the source file they show that the files are the 'Same' in the Difference column,
but one target system may differ from another because of the rules in the source file. To show which target
systems have the same content as other target systems, the files are check-summed. When the checksum is
the same as another system, then the files really are the same! To arrange servers into groups with the same
file content - sort the display by clicking on the "Checksum" column header. This sorts the lines in the display
based on their checksum value.

oS This version of Windows on the target server (this information is not always available).

Version

Temp File | This is the name of a temporary file used for updating the target file. It is automatically removed after the update.

This display created 11-Jan-2010 by Sysgem AG




5.2 Startup

Select the SEM Agents on Windows servers where a comparison is to be made of target files against the selected source file.

5.3 Menu Options

5.3.1 List Target File

This option lists the current contents of the target file; no updates are made.

5.3.2 List Source File

This option lists the updated contents for the file based on the central database.

5.3.3 Show Differences

This option show the differences between the update file and the current target file.

5.3.4 Update Target File
This option:
1. Runs the pre-processing script.

2. Updates the target file by copying the new contents over the existing contents.
3. Runs the post-processing script.



6 Auto-Start Monitor

6.1 Description

This display is used to start the synchronize window using a nominated source file and
a nominated set of target agents. It is primarily used as a "Service Display" to run in
unattended mode so that alarms may be set to take action 24/7 (e.g. to report when a
target file becomes out-of-sync with the central source file).

Start this display by selecting the agent where the source files are held. Select the
required platform type (UNIX/Windows/VMS) and identify the required source file in the
startup parameters. If the source file has the file extension ".bfe", i.e. it is an encrypted
file then you will need to enter the encryption key. The site default key will be
automatically provided by default. If this file has a private key which is different to the
site-key, then you will need to re-enter the value in the "Encryption Key" field before
continuing. Finally, Select the list of target agents on which the synchronize display is
to be started.

Follow the following steps to start the window as an unattended Service Display:

Select the main SEM Menu option "Tools"

Select the option "Service Displays"

Select the "Auto Start Monitor" display

Add the display to start automatically as a Windows Service by selecting: "+

Configuration”

Select the "Enable" button

e click on "Schedule" and change the scheduled interval settings appropriate to
the type of target files

e Click on "Parameters" and select the Agent that holds the source files; the
target platform type (UNIX/Windows/VMS); the name of the source file
(including file extension such as .txt or .bfe): the encryption key if the source file
is encrypted (e.g. it has a ".bfe" file extension) and select the target agents.

e Select an alarm: e.g. "SFiS: Report Out-of-Sync Files". Note that the example

alarm provided with SFiS requires the email address to be added by editing the

alarm under the "Alarms" selection pane (normally on the left of the screen

above the "Displays" selection pane).

The display will now start on the local server and invoke the synchronize display on the
target agents.

It is recommended to run the "Auto Start Monitor" interactively and to test that the
alarm will trigger with out-of-sync files before the display is submitted as a 'Service
Display'. To run the display interactively, simply double click on the "Auto Start
Synchronize" display under the "Supervisor" folder and after the Synchronize window
has started select and apply (double click) the alarm under the Alarms Selection pane
making sure that the Synchronize window is also the window that is currently selected.

Before the Alarm will send mail correctly, the recipient email address needs to be
added by editing the alarm and setting the email address on the "Email" tab (found on
the left of the Alarm Editor).

This Display was created 26-Feb-2010 by Sysgem AG



6.2 Startup

Start up Parameters for the Auto Start Monitor

Select the Agent that holds the source files at the top of the startup window.

Select the Platform Type for the target servers

Enter the name of the source file including the file extension such as ".txt" or ".bfe".

If the file is an encrypted file - enter the Encryption Key. (This field will be pre-filled with
the system-wide default and if this still appropriate for this file then it need not be re-
entered).

Finally, select the target agents that are to be monitored and press "OK" to start the
SFiS File Synchronizer window to monitor the target systems.

24/7 Monitoring

For continuous monitoring and sending alarms through email: use this display as a
"Service Display".

To start the display as a "Service Display" use the following main SEM menu options:
"Tools" > "Service Displays"

... then select the "Auto Start Monitor" display and press the "Add Configuration”
button.

... If you are going to have several instances of the display running at the same time,
for example if you want different groups of servers to be sending alarms to different
people, then enter a name for the new configuration that matches the monitoring
purpose of this instance.

... select the "Enable" checkbox and define a schedule for when and how frequently the
display should be run.

... click the "Parameters" button and enter the startup parameters by:

e selecting the SEM Agent that holds the Source Files;

e selecting the platform type of the target servers;

¢ identifying the required source file (that you have previously created and tested
using the SFiS Source File Manager and File Synchronizer);

e entering the encryption key (if appropriate);

e selecting the target servers to be monitored.

... finally, select the appropriate Alarm in the "Apply Alarm" field and press "OK" to save
the Service Display Configuration setup.

The SFiS monitoring display will now run continuously in background mode as a
"Service Display" refreshing the contents of the display from the target servers to the
schedule defined in the settings above.



Multiple instances of the display can be started with different schedules, different target
servers, different source files (and consequently different target files) and with different
alarm and / or filter settings.

Interactive Use of this Display

Test the use of this display by starting it interactively while you are logged in to SEM.

Test the use of it with different source files, different target servers and different alarms
before starting the display for continuous (24/7) monitoring of your networked servers.

Customizing Alarms

SFiS has an example alarm that may be copied into your own personal alarm library
and from there it can be customized and replicated to produce different variants.

Select the Alarm selection pane (on the left of the SEM screen) and open your "Own
Library" folder.

Double click on the "Edit" icon under the Alarms "Own Library".

Select the menu option "Import" - "From User or Library", and select the "Library:
SFiS File Synchronizer" library and click "OK".

Select the "SFiS: Report Out-of-Sync Files" alarm and add it to your own library by
pressing the "Add" button.

Double click on the new alarm added to your library to edit it and select the "email" tab
(on the left of the Modify Alarm window). Change the Address entry that says <Set your
email address here> to be the email address of the person who should be notified
when target files are no longer match the source file. Press OK to complete the edit
and press "OK" again to save the changes in your own library.

Setting Alarms on Running Displays

When a "SFiS File Synchronizer" window has been started interactively and it is the
display window that is currently selected, change the selection pane (on the left of the
SEM screen) to be "Alarms". Navigate to the appropriate Alarm and double click on it.
It will then be applied to the selected running display window. To remove it, click on the
"Alarm" icon (a bell) at the bottom of the display window and click on the "Remove"
option and the alarm will be removed from the window.

Setting Alarms on Service Display Windows

See the section above under "24/7 Monitoring"

6.3 Menu Options

6.3.1 Start_Synchronize



This menu option is automatically invoked when the display window is started. It
automatically starts the Synchronize display using the target agents selected in the
startup parameters.

The following is a list of startup parameters:

Agent (that holds the source files)

Target agent platform type (UNIX/Windows/VMS)
File name (with file extension)... e.g. "test1.bfe"
The encryption key if the file is encrypted

List of Target Agents



7 Import Candidates

7.1 Description
This window allows source files to be built from target files.

Target files from remote servers (UNIX/Windows/VMS) are gathered as candidates for
adding into the source folders. After selecting one of the candidate files it can be used
for creating a new source file. A 'Preview' option allows the source file to be viewed
before it is actually created.

After a source file has been created from a single target disk, one or more other target
files may be selected and "Merged" with the original source file.

Created 2010-03-05 06:25:26 by FileSync

7.2 Startup

Select the SEM Agents on UNIX/ Linux / Windows / VMS servers where files are to be
gathered to be used as possible candidates for creating new source files.

Enter the target file name (the full file specification) and the name/type/folder for the
new source file, plus the agent that hosts the source file folders.

7.3 Menu Options

7.3.1 Create Source File from Target

Select a single file from the display and then use this option to create the 'Source File'
on the agent that hosts the source file folders.

You may preview how the file will look before creating it by using the Mode: "Preview"
option on the input form.

7.3.2 Merge Target File into Source

Select one or more entries from the display and then use this option to preview the file
before it is updated on the agent in the source file folder.

When you are satisfied with the preview, use the "Merge" (instead of "Preview") option
on the input from to update the source file.



8 SFiS Audit Browser

8.1 Description

This window gives a complete history of all updates made to the source files and to the
files on target servers as recorded in the SFiS Audit database.

Access to this display window is controlled by the token setting "Audit Browser" under
the "Menu Options" folder in the "SFiS File Synchronizer" Access Control Token. It is
always available to the SEM "System" account.

The history of all updates can be browsed showing who performed the update, when
the update was made, which files on which target systems were changed, etc.

As with all SEM display windows, this window may be sorted on the content of any
field, it may be filtered and extracts may be taken into HTML reports, Word / text
documents, spreadsheets, etc.

Database Format

The database format is assumed by default to be based on Microsoft Access, but this
can be changed to SQL Server. To change the database type to SQL Server, create a
new (empty) database using the Microsoft SQL Server Enterprise Manager. Then on
the SEM Authorization Server machine, modify the ODBC System DSN to use the SQL
Server driver and point the DSN to the new database just created. Finally, set the
"SFiS File Synchronizer" Access Control Token: "Database Type" to "SQL Server" to
prevent the default being reset to MS Access.

8.2 Startup

Input Values
Select the SEM Agent on the Authorization Server.

To select specific entries from the database, apply a filter argument in the start-up
window as follows:

e Enter a value in the Textfield, for example the name of the SEM User whose
entries are to be displayed,

e Check Exact if the value you entered must match the record's value exactly, or
just leave the Exactfield clear to display all records containing this value,

e Select the Field for the match from the dropdown list.



Press Apply to display all entries that match the above criteria. If the Text field is left
empty then no filtering takes place and all records in the database are available for

display.



9 Release Notes

** Important Standing Notices™*
A. SEM Agent on Windows:

If upgrading SEM from a version prior to SEM Build 4286, then please
note that *All* components of SEM should have a minimum build of
4286.

B. Access Control Tokens:

1. A question is asked, when Importing the Sysgem File Synchronizer
Module, whether you want to over-write the Access Control Tokens.
Generally it is NOT necessary to import and over-write the tokens with
every upgrade of the File Synchronizer. However, if upgrading from a
version released prior to: 20-Mar-2010 then you SHOULD import the
new token, and check whether any new options should be selected.

9.1 Interim Release Based on SEM Build: 4415

Sysgem File Synchronizer Release Date: 23-Mar-2010

SEM Component Minimum Comment
Build
Management Console 4415 For a number of SFiS compatibilities -

including performance when connecting
to large numbers of servers and starting
the Automatic Monitor Display

correctly.
Authorization Server 4341 For compatibility with SEM v2.3.
NT Agent 4341 For compatibility with SEM v2.3.
UNIX Agent 4286 For compatibility with SEM v2.3.

VMS Agent 4341 For compatibility with SEM v2.3.




AS400 Agent NA NA

*¥* Changes Since Last Release **

e Bug Fix: A problem merging a captured candidate file with a source file when
there was an underscore in the file name or the agent name has been
corrected.

Sysgem File Synchronizer Release Date: 20-Mar-2010

SEM Component Minimum Comment
Build
Management Console 4415 For a number of SFiS compatibilities -

including performance when connecting
to large numbers of servers and starting
the Automatic Monitor Display

correctly.
Authorization Server 4341 For compatibility with SEM v2.3.
NT Agent 4341 For compatibility with SEM v2.3.
UNIX Agent 4286 For compatibility with SEM v2.3.
VMS Agent 4341 For compatibility with SEM v2.3.
AS400 Agent NA NA

*¥* Changes Since Last Release **

Enhancement: A new menu option has been added to the "Capture -
Candidates" display window: "Merge Target into Source". This menu option
can be used after the option "Create Source from Target" has been run to
create the first version of a source file. After the Merge option has been run
with target files against this created source file, then the differences between
the different target files are recorded in the source definition. This is a "first
release" of this menu option and it does not yet support:

o different named target files or where the path to the target file is different
between servers

the recognition of "variables" in source files

'data include files' in source files

pattern matching to identify when different target servers have the same
differences in the same position of a source file

o

(@)

o




o pattern matching to identify new possible "variable" substitutions

Sysgem File Synchronizer Release Date: 12-Mar-2010

SEM Component Minimum Comment
Build
Management Console 4415 For a number of SFiS compatibilities -

including performance when connecting
to large numbers of servers and starting
the Automatic Monitor Display

correctly.
Authorization Server 4341 For compatibility with SEM v2.3.
NT Agent 4341 For compatibility with SEM v2.3.
UNIX Agent 4286 For compatibility with SEM v2.3.
VMS Agent 4341 For compatibility with SEM v2.3.
AS400 Agent NA NA

*%* Changes Since Last Release **

e Enhancement: The "Include Files" folder displayed by the Source File
Manager has been split into two: "Data Include Files" and "Script Include
Files". Additional Access Control Token settings have been added to grant
access to these folders and additional validation of Include files as they are
being created or edited takes place depending on whether the file is a data
include file or a script include file. The "Load Example Source File" now
creates include files in the two new folders.

e Enhancement: A new menu option has been added to the Source File Manager
- "View Source File" menu of: "View as Data for Agent". This option
prompts for a target agent and displays the data portion of the source file in a
form that would be used for an update or a comparison with the target file.

Sysgem File Synchronizer Release Date: 05-Mar-2010

SEM Component Minimum Comment
Build
Management Console 4415 For a number of SFiS compatibilities -

including performance when connecting




Authorization Server
NT Agent

UNIX Agent

VMS Agent

AS400 Agent

4341
4341
4286
4341
NA

to large numbers of servers and starting
the Automatic Monitor Display
correctly.

For compatibility with SEM v2.3.
For compatibility with SEM v2.3.
For compatibility with SEM v2.3.
For compatibility with SEM v2.3.
NA

*¥* Changes Since Last Release **

e Enhancement: A new display: "Capture -> Import Candidates" has been
added to SFiS to allow source files to be built from target files. In this release
two menu options have been added to this new display window: "Create
Source File" and "Preview - Create". The window allows candidates for
bringing into the source folders to be gathered from remote target systems
(UNIX / Windows / VMS) and after selecting one of the items, a source file
can be created from the content of that file. The 'preview' option allows the
user to view how the source file will look, without actually creating it. The
next release of SFiS will introduce two new options to "Merge" a target file
with an existing source file and to "Preview" the merge option without
actually updating it. The "Merge" and "Preview Merge" will be able to be run
with multiple selected files to merge several files in one operation.

Sysgem File Synchronizer Release Date: 04-Mar-2010

SEM Component

Management Console

Authorization Server
NT Agent

UNIX Agent

VMS Agent

AS400 Agent

Minimum
Build
4396

4341
4341
4286
4341
NA

Comment

For a number of SFiS compatibilities -
including performance when connecting
to large numbers of servers

For compatibility with SEM v2.3.
For compatibility with SEM v2.3.
For compatibility with SEM v2.3.
For compatibility with SEM v2.3.
NA

*¥* Changes Since Last Release **

* Bug Fix: A problem of not finding illegal edits of clauses in source files (when
the token prohibited changes to a particular clause) has been fixed in this




release.

e Enhancement: The "Load Example Source File" option now includes
examples of variable definitions contained within the source file text.

e Enhancement: A new display: "Auto-Start Monitor" has been added to
automatically start the Synchronization Display as 'SEM Service Displays' -
allowing multiple instances to be run in unattended mode (24/7) and to have
alarms set to raise email warning messages when target files are found to be
out of sync with the central source definitions. Example Alarms and Filters
are shipped with the module.

e Bug Fix: A number of problems resulting from when a VMS source file /
include file contained a double quote character have been resolved.

Sysgem File Synchronizer Release Date: 18-Feb-2010

SEM Component Minimum Comment
Build
Management Console 4396 For a number of SFiS compatibilities -

including performance when connecting
to large numbers of servers

Authorization Server 4341 For compatibility with SEM v2.3.
NT Agent 4341 For compatibility with SEM v2.3.
UNIX Agent 4286 For compatibility with SEM v2.3.
VMS Agent 4341 For compatibility with SEM v2.3.
AS400 Agent NA NA

*¥* Changes Since Last Release **

e Enhancement: More validation and formatting of source file. Plus a bug fixed
in the existing validation code, resulting from the situation when a source file
error was ignored by the user leaving the error message in the source file. The
result was a checksum error after the 2nd edit of such a file. This has now
been corrected.

¢ Enhancement: Line numbers have been added to the "List Target File" and
"List Source File" on the "Synchronize Target File - UNIX" display. (As is
already shown for Windows and VMS).




Sysgem File Synchronizer Release Date: 17-Feb-2010

SEM Component Minimum Comment
Build
Management Console 4396 For a number of SFiS compatibilities -

including performance when connecting
to large numbers of servers

Authorization Server 4341 For compatibility with SEM v2.3.
NT Agent 4341 For compatibility with SEM v2.3.
UNIX Agent 4286 For compatibility with SEM v2.3.
VMS Agent 4341 For compatibility with SEM v2.3.
AS400 Agent NA NA

*¥* Changes Since Last Release **

o Bug Fix: If a source file was saved in UTF-8 format (using the Create or Edit
command), then the UTF-8 BOM gave a problem and an error was displayed
when saving the file. This problem has now been corrected.

e Bug Fix: A problem when trying to export a source file as a text file
(complaining of an invalid checksum) has now been fixed.

* Enhancement: A better way of displaying errors in source files has now been
implemented. The error message is left within the source file but now the
original line (commented out) appears at the start of the error line - not the
end of the error line.

Sysgem File Synchronizer Release Date: 16-Feb-2010

SEM Component Minimum Comment
Build
Management Console 4396 For a number of SFiS compatibilities -

including performance when connecting
to large numbers of servers

Authorization Server 4341 For compatibility with SEM v2.3.
NT Agent 4341 For compatibility with SEM v2.3.
UNIX Agent 4286 For compatibility with SEM v2.3.




VMS Agent 4341 For compatibility with SEM v2.3.
AS400 Agent NA NA

*¥* Changes Since Last Release **

e Enhancement: This version of SFiS supports the synchronization of target
files on OpenVMS Servers.

Sysgem File Synchronizer Release Date: 10-Jan-2010

SEM Component Minimum Comment
Build
Management Console 4396 For a number of SFiS compatibilities -

including performance when connecting
to large numbers of servers

Authorization Server 4341 For compatibility with SEM v2.3.
NT Agent 4341 For compatibility with SEM v2.3.
UNIX Agent 4286 For compatibility with SEM v2.3.
VMS Agent NA NA
AS400 Agent NA NA

*¥* Changes Since Last Release **

e Enhancement: This version of SFiS supports the synchronization of target
files on Windows Servers.

e Performance Enhancement: This version of SFiS has significant performance
improvements when synchronizing large files (e.g. more than 1K lines) with
large numbers of servers (e.g. in excess of 1000 servers). SEM Build 4396 or
later is required for this feature.

e Enhancement: This version has automatic tiling of windows when invoking
the Synchronize Target Files menu options. SEM Build 4396 or later is
required for this feature.

Sysgem File Synchronizer Release Date: 09-Dec-2009




SEM Component Minimum Comment
Build

Management Console 4333 For menu option "Load Example
Source File" & Control Token: "Can
Define Own Encryption Key"

Authorization Server 4286 For compatibility with Build 4286, all
SEM components must have a
minimum build of 4286

NT Agent 4286 For compatibility with Build 4286, all
SEM components must have a
minimum build of 4286

UNIX Agent 4286 For compatibility with Build 4286, all
SEM components must have a
minimum build of 4286

VMS Agent NA NA
AS400 Agent NA NA

*%* Changes Since Last Release **

o Bug Fix: Validation of source file during create / edit did not allow the Clause
"G" (to define Agent Groups). This problem has now been fixed.

n,n n_mn

e Enhancement: Give warning if "agent clause" does not have a "+" or "=" or "-
" following the "A " in a source file when completing a create or edit.

e Enhancement: Give warning if the minimum set of clauses have not been
entered in a source file when completing a create or edit.

9.2 SEM Build: 4333

SEM Release: Version 2.3 Build 4333,

Date: 09-Dec-2009

Sysgem File Synchronizer Release Date: 09-Dec-2009

SEM Component Minimum Comment



Build

Management Console 4333 For menu option "Load Example
Source File" & Control Token: "Can
Define Own Encryption Key"

Authorization Server 4286 For compatibility with Build 4286, all
SEM components must have a
minimum build of 4286

NT Agent 4286 For compatibility with Build 4286, all
SEM components must have a
minimum build of 4286

UNIX Agent 4286 For compatibility with Build 4286, all
SEM components must have a
minimum build of 4286

VMS Agent NA NA
AS400 Agent NA NA

*¥* Changes Since Last Release **

e Enhancement: Source: File Management has been added to the module. A
new window to "List Source Files" has been added that gives a 'File Explorer’
of two folders "UNIX Source Files" and "UNIX Include Files". Files within
these folders are managed with a set of menu options. The following menu
options are included:

- Create Source File

- Edit Source File

- Show Source + Expanded Includes
- Copy Source File

- Rename Source File

- Delete Source File

- Import Source File (from text file)
- Export Source File (to text file)

- Load Example Source File

- Audit Browser

- Unlock Source File

- Repair Checksum (on Source File)
- List Source File

- List Target File

- Show Differences

- Update Target File

The existing File Synchronizer window is now invoked by selecting a source
file in the above explorer window and selecting the menu option
"Synchronize Target Files".



9.3 SEM Build: 4286

SEM Release: Version 2.3 Build 4286,

Date: 24-Oct-2009

Sysgem File Synchronizer Release Date: 25-Nov-2009

SEM Component Minimum Comment
Build
Management Console 4333 For compatibility with Build 4286, all

SEM components must have a
minimum build of 4286

Authorization Server 4286 For compatibility with Build 4286, all
SEM components must have a
minimum build of 4286

NT Agent 4286 For compatibility with Build 4286, all
SEM components must have a
minimum build of 4286

UNIX Agent 4286 For compatibility with Build 4286, all
SEM components must have a
minimum build of 4286

VMS Agent NA NA
AS400 Agent NA NA

** Changes Since Last Release **

e Enhancement: The "File Synchronizer - UNIX" display has now been updated
with Access Control Tokens that control access over menu options, restricted
files, etc. See the menu option:

Managers
SEM Users
Tokens
"SSyM File Synchronizer"

... copy the token into different named variants, set the appropriate options,
and add a variant to different "Prifiles" for different types of users.



e Enhancement: The "File Synchronizer - UNIX" display has now been given
Audit Logging for "Update" transactions. An Audit Browser has been added
as a new SEM display for the review of File Synchronizer transactions.

9.4 Historical Release Information

April 21st 2009
Default shell now ksh instead of bash.

The V clause should now work in pre-processing.

February 18th 2009

Only the agents which are updated get refreshed. Added a Checksum column to the
display.

March 27th 2008

Resolved age-old problem with UNIX and Linux not behaving the same way when
echoing strings containing delimiters, see main pre-processing script where the IF field
is echoed from the U**X target.

March 12th 2008

The field delimiting now works correctly.

March 12th 2008

The F syntax now supports groups as well as * and agent names in the first parameter.

March 11th 2008



Backticks now delimited (*) so that commands such as:
print grep{/"# usage:/ .. /"#$/} “cat $SSCRIPT_NAME";
work correctly.

The W field now supports variable substitution.

June 6th 2007

Added CSV support for the V (variable) syntax, really just correcting a previous
omission.

April 25th 2007

Added C and I syntax. The input file is scanned for C and I entries before processing
other commands.

November 22nd, 2004

The Data entries (which start with a D + <space>) no longer have leading white space
removed (the white space on the left of the entry).

$ in the Data entries is now preserved correctly, it is no longer necessary to enter \$
instead of $.



